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Introducing DepoView 

1 

DepoView™ is an easy way for parties without deposition management software to view 
synchronized digital video. DepoView™ also has clip editing and clip export tools, which 
add even more value to Digital Video Transcripts.   

 Your clients will love the convenience and the simplicity! 

 Easy to use word index instantly hyperlinks you to crucial portions of the testimony. 

 Just highlight the transcript to make video clips. 

 Export clips to PowerPoint with synchronized text. 

 Export to other major programs like TrialDirector, CT Summation products, and 

Sanction. 

 Search and jump to any keyword.  

 Copy and paste key testimony excerpts for use in summaries, motions, and briefs. 

 View exhibits related to the deposition. 

 View video transcript testimony synchronized to the deposition text. 

 Create single and multi-segment clips. 

 Export clips to MPEG files. 

 Email videos of clips. 

 New User Interface:  The DepoView 6 user interface has been overhauled to 

provide an improved user experience. The DepoView 6 application window can be 

resized so it is easily viewable on high resolution displays, and the video window can 

be expanded and resized to accommodate high resolution video formats. Additionally, 

the Word Index and Exhibits tabs are immediately accessible for easy navigation and 

use when reviewing a deposition. 

 MPEG-4 (H.264) Support:  DepoView 6 now supports MPEG-4 (H.264) video. This 

update ensures that clients receiving DepoView volumes using MPEG-4 (H.264) video 

files will be able to properly playback the content, as well as create and export clips.  

 Page Search Functions:  Just type “pg” plus the desired transcript page and 

DepoView will immediately jump to that page and area of the synchronized 

deposition video. For example, typing “pg154” will immediately jump the transcript to 

Page #154 of the deposition and seek the associated video to that location. 

 Improved Clip Review & Editing:  The SHIFT or CTRL keys can now be used in 

conjunction with a mouse click to immediately jump to any line within a single or 

multi-segment clip within the DepoView clip review or editing areas. 

 Sortable Clip Lists:  DepoView 6 enables you to sort clips based upon Clip ID, 

Description, or Segment Count. 

 New Menu Keystrokes:  Press F1 to open DepoView Help, press CTRL+O to open a 

transcript, and press CTRL+P to open the DepoView Print dialog box. 

 TrialDirector 6 Integration:  DepoView 6 has been updated to allow users to send 

transcripts and clips to TrialDirector 6. 
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The recipient of a DepoView volume can easily view the synchronized digital video 

transcript, create clips, export clips and search the deposition testimony. The DepoView 

software is easy to operate for first time users, yet is powerful enough for the seasoned 

professional.  

1. After you insert a DepoView CD/DVD, the DepoView application is automatically 
launched. 

2. If you have trial presentation software and the transcript is not currently loaded in 
your software, the following window will appear.  

 

3. Select the software you would like to add the transcript to, and choose whether to
add now, add later, or never add.  

Note: If you choose never to add the transcript and then decide later to add 

it, select SEND TRANSCRIPT TO from the FILE menu to get this window again. 

4. Once the transcript has been loaded, the DepoView application window will appear. 
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Exhibit Link An exhibit link will appear next to the line where 
an exhibit is first mentioned in the transcript. 

Click on an exhibit link to view the exhibit. 

Search Transcript Type in a phrase, a word or part of a word and 
click [Go] to search the transcript. Click [Go] 
again or press the [F3] key to find the next 
occurrence. 

Hi-Lite Button Click the Hi-Lite button to activate the Hi-Liter, 

and use it to highlight the transcript text from 
which you would like to create a clip.  

Clip Button Click the Clip button to create a clip from the 
highlighted text in the Transcript.   

Note: To create a clip, the text that is going 

to be part of the excerpt MUST be highlighted 

first with the Hi-Lite tool. 

Full Screen Video Click the Full Screen Video button to play the 
video in full screen mode. While in full screen 
mode, press the spacebar or right-click on the 

video to play or pause the video. Press the 
Escape [ESC] or [Enter] key to return to normal 
viewing mode. 

Word Index Use the Word Index to quickly go to a location 
where a specific word is used in the transcript. 
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Exhibits Use the Exhibits List to see all exhibits linked to 
the transcript. Double-click an exhibit to open it. 

Show/Hide Clip 
List 

Show or hide the Clip List window. 

Play/Pause Play or pause the DVT. 

Stop Stop playing the DVT. 

Seek Click and drag the Seek bar to move back and 
forth through the video.  

Jump to Previous 
Page 

Jump to the previous page in the Transcript. 

Jump to Next Page Jump to the next page in the Transcript. 

Adjust Volume Adjust the sound volume up or down. 

Take Snapshot Click to take a snapshot of the current video 
frame and save it as a bitmap. 
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If the DVT you are viewing spans multiple disks, you can avoid having to switch disks while 

working with the DVT by copying the entire DVT to your hard drive.  This is strongly 

recommended if you are going to be working extensively with the DVT. 

1. On the File menu, click Copy Video Files to Local Hard Drive.   
2. Click OK to copy the DVT into the folder shown, or click Browse to select a 

different folder. 
 

 
3. Click OK to begin copying the files. You will see a window showing the copy 

progress. 

 

 
4. If your DVT spans multiple disks, you will be asked to insert the next disk after the 

first disk has been copied. Insert the next disk and click OK. 
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5. A message will inform you when the copy is complete. Click OK. 
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1. Click the Full Screen Video button or hold down the [ALT] key and press the [Enter] 
key. 
 

 
2. The video will expand to full screen. 
3. While in full screen mode, use the following commands:  

o To play or pause the video, right-click on the video and select Play or 
Pause from the menu or press the spacebar. 

o To exit full screen mode, press the Escape [ESC] or [Enter] key. 
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To search the transcript for a word, phrase, or page number 

1. Type a phrase, a word, or part of a word in the Search box. 
-or- 
If searching for a page, type pg followed by the page number (i.e. pg10). 

2. Click Go or press the [Enter] key. 
3. If a match is found, the line containing the match is highlighted. 
4. Press the [Enter] key to begin playing the video at the search result.  
5. To search for additional matches, do one of the following:  

o Press Go or the [F3] key. 
o On the Edit menu, click Find Next. 

6. The highlighted line will move to the next match, if found. 
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1. On the File menu, click Print Transcript. 
2. Select the desired print format: Full Page, Condensed (4 to a page), or Word 

Index. 
 

 
3. If you would like to change the paper size, orientation, or margins, click Page 

Setup. 
4. If you would like to preview the printout, click Preview. 
5. Click the Print button or the printer icon to print the transcript. 
6. When the Print window appears, adjust the print options, if desired, and click Print 

to begin printing. 
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To create a bitmap image of the current video frame 

1. Click the camera located below the Video. 
 

 
2. Select the folder where you want to save your Snapshots and either keep the 

default file name or enter a different one. 
3. Click Save. The Snapshot will be saved as a bitmap file. 

Note: Make sure that Microsoft DirectX 8 or higher is installed in order to save 

snapshots. 
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Browsing the Word Index 

1. To find a word in the Word Index, type a word in the Search field or use the 
scrollbar to browse. 

2. Click on a page and line number to jump to a particular occurrence of a word in the 
transcript. The video will move to the location associated with the page/line 
number. 

Rebuilding the Word Index 

1. On the File menu, click Rebuild Transcript Indexes. 
2. A screen will appear while DepoView rebuilds the transcript indexes and will close 

when the process is complete. 
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Viewing a Linked Exhibit 

1. Find the first mention of the exhibit you would like to view by searching the 
transcript or scrolling to it. 

2. Click on the exhibit link next to the line where the exhibit is mentioned.  

 

3. The exhibit will open in the program that is associated with that file type on your 
computer. 

Browsing the Exhibit List 

1. Click the Exhibits tab. 
2. Use the scrollbar to browse the Exhibit List. 

 

 
3. Click on an exhibit to view it in the program that is associated with that file type on 

your computer. 
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A clip consists of one or more segments of a Digital Video Transcript that can be played 
successively. Clips can capture pertinent testimony without interruptions such as 
objections or irrelevant information.  

Note: If your DVT spans multiple disks, it is recommended that you copy the DVT to 

your hard drive to avoid having to switch disks while you are working with clips. 

  

What would you like to do ? 

 Create a Clip 
 View Clips 
 Edit a Clip 
 Rename a Clip 
 Delete a Clip 
 Export or Email Clips 
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1. If your DVT spans multiple disks, it is recommended that you copy the DVT to your 
hard drive before creating any clips. 

2. Select the Hi-lite tool by clicking on the Hi-lite button once. 
 

 
 
The mouse cursor will change into a highlighter when you move it over the 
transcript. 

3. Click on the first line of the text that you want to make a clip of and drag down to 
the last line that you want to include in the clip. The highlighted area will turn 
yellow.  

 

 

Note: If you accidentally select a line that you do not want in the clip, you can 
either click the Hi-lite button twice and start over or right-click on the line you don't 
want and select Remove Line Highlight from the drop-down menu.  You can also 
deselect an entire highlighted segment by right-clicking on the segment and 
selecting Remove Segment Highlight from the drop-down menu. 

4. Once you have highlighted the desired text, click the Clip button. When you make 
the clip you should hear a tone. 

 

 
5. Once the clip has been created, it will be displayed in the clip window. 

Note: If you want to view clips automatically after creating them, make sure the 

"Show each clip after it's created" option on the Clips menu has a checkmark next to it.  If 

it does not, click on it to enable it. 
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Sometimes it is desirable to create a clip that contains multiple blocks of transcript text, 

allowing you to exclude objections or irrelevant information from the clip while keeping 

related testimony in the same clip. In this case, you should create a multi-segment clip. 

1. Follow steps 1-3 above. 
2. Repeat step 3 to select additional blocks of transcript text to add to the clip, as 

desired. 
3. Click the Clip button. 

 

 

  

4. The default selection is to combine the text selections into a single clip. 
5. Click OK.  When the clip is created, you should hear a tone. 

Note: If you want to view clips automatically after creating them, make sure the 

Show each clip after it's created option on the Clips menu has a checkmark next to 

it.  If it does not, click on it to enable it. 

  

1. Follow steps 1-3 of "Creating a Clip". 
2. Repeat step 3 to select additional clips, as desired. 

3. Click the Clip button. 
4. Select Make each selection a separate clip. 
5. Click OK.  When the clips are created, you should hear a tone. 

Note: If you want to view clips automatically after creating them, make sure the 

Show each clip after it's created option on the Clips menu has a checkmark next to 

it.  If it does not, click on it to enable it. 
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To open and view the Clip List you can do either of the following: 

 On the Clips menu, click Show Clip List. 
 Click the Show/Hide Clip List button located below the video. 

 

 

When the Clip List is open, five tool buttons will appear above the Clip List: 

 

 

  

Rename Click the Rename button to change the Clip ID or 
the Clip Description of the clip that is currently 
selected in the Clip List. 

Edit Click the Edit button to change the start and end 
times of a clip or clip segment. 

Export Click the Export button to email a clip or to export 
it to a file, a PowerPoint® presentation, or your 

trial presentation software. 

Delete Click the Delete button to delete a clip. 

Done Click the Done button to return to the full 
transcript. 

Clip ID The Clip ID field is used to identify the clips. The 
ID is made up of the deponent's initials and the 
page and line number of the first line in the clip 
(i.e. MP-00006-09). The Clip ID can be edited 
when you rename a clip. 

Clip Description The Clip Description field is the first line of 
transcript text in the clip by default. The Clip 
Description field can be edited when you rename 
a clip. 

Segs The Segs field shows the number of segments in 
the clip. 
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When you play a clip, you may notice that the start and stop times of the video are not 
exact. When this is the case, you can edit the start and stop times to be earlier or later, as 
needed.  

Note: The more accurately the transcript was synchronized to the video, the fewer 

adjustments you will need to make to the clips. 

  

To edit a clip 

1. Select the clip from the Clip List that you want to edit. 
2. Click the Edit button. 

3. Click the Jump to Start button to determine whether the start time needs to be 
adjusted. Use the green adjustment buttons to adjust the start time by one second 
at a time, as needed. 
 

 

Note: Hold down the [Shift] key while clicking the adjustment buttons to 
adjust the times by 1/10 of a second. 

4. Click the Jump to End button to determine whether the end time needs to be 

adjusted.  Use the red adjustment buttons to adjust the end time by one second at 

a time, as needed. 

5. If there are additional segments in the clip (as denoted by a segment break), 
double-click anywhere on the next segment in the clip and repeat steps 3 and 4 to 
edit each additional segment. 

6. Once you are finished editing, click the Save button. 
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To change the Clip ID or Clip Description used to identify a clip 

1. Select the clip from the Clip List that you want to rename. 
2. Click the Rename button. 
3. Modify the clip information as desired. 

 

 
4. Click OK to save your changes. 
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To delete one or more clips from the Clip List 

1. Select the clip(s) you want to delete from the Clip List.  Use the [Shift] key to select 
multiple clips. 

2. Click the Delete button. 
 

 
3. Click OK to confirm that you want to delete the clip(s). 
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Exporting and emailing clips allows you to share clips with others, move them to other 
disks, or load them into your trial presentation software.  

  

What would you like to do? 

 Export Clips to a File 
 Email Clips 
 Export Clips to a PowerPoint Presentation 
 Export Clips to Trial Presentation Software 
 Export a Clip Creation Script (.ccs) 
 Email a Clip Creation Script (.ccs) 
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1. Click the Show/Hide Clip List button to open the Clip List if it is not already open. 

 

2. Select the clip(s) you would like to export. 

The [SHIFT] key is no longer required. 

3. Click the Export button.  

4. The clip(s) you selected in step 2 will be selected. 

 

 

5. Check the box next to any other clips you would like to export, or click Select All to 

select all clips. Click Next. 

6. By default, the exported clips will be sent to a file folder. 

 



DepoView User Manual 

22 

 

7. The standard Resolution & Quality of "Auto" is selected by default.  Select a 

different resolution, if desired.  The list of Resolution & Quality options is ordered 

from lowest resolution to highest. 

 

Note: When the Resolution & Quality output is set to "Auto", the output file 

settings are based upon the attributes of the source multimedia file. For example: 

DepoView will output a DVD-compliant MPEG-2 file when the source file is a DVD-

compliant MPEG-2 (720 x 480 resolution, video bitrate is 8000 kbps, audio bitrate is 

224 kbps).  

8. If you would like to change the destination folder, enter a destination folder or click 

Browse to select one.  If the destination folder you have entered does not exist, 

DepoView will create it for you. 

9. Select Add synchronized text captions in video files if you want the clip text to 

be shown along with the video when the clip is played and captions are turned on. 

10. Click Next. 

11. If you want to add a video transition at the beginning and end of each clip (and all 

segments within the clip), select a transition from the list. 

 



DepoView User Manual 

 

23 

 

12. If you have selected to add video transitions, select a transition time from the list. 

13. Click Send. 

14. Click Done. The clip(s) will be exported to the folder you selected. 

15. To play an exported clip, go to the folder where you exported the clip and double-

click on it.  The clip will be an MPEG file with the Clip ID as the filename (e.g., MP-

00005-09.mpg). 

Note: If you selected Add synchronized text captions in video files, there will 

also be a (.smi) file with the same filename in the folder.  This file must be in the same 

folder as the MPEG file in order for the captions to be displayed when you play the clip. 
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1. Click the Show/Hide Clip List button to open the Clip List if it is not already open. 

 

2. Select the clip(s) you would like to export. 

The [SHIFT] key is no longer required. 

3. Click the Export button. 

4. The clip(s) you selected in step 2 will be selected. 

 

 

5. Check the box next to any other clips you would like to export, or click Select All to 

select all clips. 

6. Select Email Recipient. 

7. Click Next. 
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8. If you want to add a video transition at the beginning and end of each clip (and all 

segments within the clip), select a transition from the list. 

9. If you have selected to add video transitions, select a transition time from the list. 

10. Click Send.  

Note: If the size of the clips attached to the email is more than 5 MB, DepoView 

will ask you whether you really want to email the clips.  Since many email servers 

limit the size of email attachments to 5 MB and sometimes less, you may want to try 

sending smaller clips or fewer clips at a time. 

11. A new email message will open in your email program with the clip(s) 

attached.  Send the email to the desired recipient(s). 

12. Click Done. 
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1. Click the Show/Hide Clip List button to open the Clip List if it is not already open. 

 

2. Select the clip(s) you would like to export. 

The [SHIFT] key is no longer required. 

Note: You should limit each clip you send to a PowerPoint presentation to 200 

lines of transcript text.  If any single clip has more than 200 lines, you may 

experience delays and playback problems in PowerPoint. 

  

3. Click the Export button. 

 

  

4. The clip(s) you selected in step 2 will be selected. 

5. Check the box next to any other clips you would like to export, or click Select All to 

select all clips. 

6. Select PowerPoint Presentation. This option will only be available if you have 

PowerPoint 97 or later installed on your computer. 

7. Click Next. 
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8. By default, the clip(s) will be exported to a new PowerPoint presentation.  You can 

also opt to add the clip(s) to an existing PowerPoint presentation. 

 

 

9. If you would like to change the destination PowerPoint file, enter a PowerPoint file or 

click Browse to select one. 

10. Select the desired slide layout: video and text, video only, or text only. 

Note: The video/text option is not available if you are running 

PowerPoint 2000 (or earlier).  These versions do not support the text 

transitions.  If you select the text only Slide Layout with either of these 

versions of PowerPoint, you will have to manually place any layered text 

boxes onto a separate slide.  For best results, use PowerPoint 2002 or later. 

11. Select the desired color scheme. (This option will not be available if you have opted 

to add the clip to an existing presentation.) 

12. Click Next.  

13. If you want to add a video transition at the beginning and end of each clip (and all 

segments within the clip), select a transition from the list. 
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14. If you have selected to add video transitions, select a transition time from the list. 

15. Click Send. While the clips are being exported, the following window will appear:  

 

  

16. This screen explains the following:  

o Overlapped Text: If the clips you have selected contain more lines of text 

than will fit in a single textbox, additional text boxes will be properly overlaid 

on each other, timed to transition as needed, and synchronize with the video 

playback (see note in step 19). 

o Pausing the Video: If you need to pause the video playback during the slide 
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show, you should do this by right-clicking on the slide background, or by 

clicking on the design view.  DO NOT pause video playback by clicking on the 

video window, as this will not pause the text transitions (see step 21). 

17. Click the (X) in the upper-right corner of the window to close this window, or click 

the box next to "Do now display this dialog in the future" to keep this window from 

appearing when you export clips to PowerPoint in the future. 

18. When the progress bars reach the end, click Done. The clip(s) will be saved to the 

PowerPoint presentation you have selected. 

19. To play the clip(s), open the PowerPoint presentation.  

Note: Each clip will appear as a separate slide. If a clip has more lines of 

transcript text than can be displayed on the slide at once, the text will appear 

overlapped.  The overlapped layers of text will be displayed in sequence when you 

run the slideshow. 

 

20. Run the slideshow to view the clip(s). 

21. To pause the video, right-click on the slide background or click on the design view (if 

using dual screens).  DO NOT pause video playback by clicking on the video window, 

as this will not pause the text transitions. 

Note: If you would like to send the PowerPoint presentation to another person or copy 

it to a CD or another computer, you should use PowerPoint's "Pack and Go" (PowerPoint 

2002) or "Package for CD" (PowerPoint 2003 or later) feature to ensure the video will work 

properly.  Consult your PowerPoint user guide for more information. 
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1. Click the Show/Hide Clip List button to open the Clip List if it is not already open. 

 

2. Select the clip(s) you would like to export. 

The [SHIFT] key is no longer required. 

3. Click the Export button.  

4. The clip(s) you selected in step 2 will be selected. 

5. Select any other clips you would like to export, or click Select All to select all clips. 

6. Select TrialDirector(tm) Case. You will only be able to select trial presentation 

software that is installed on your computer. 

7. Click Next.  

8. You can either send the clips to the last case you were working on or select a 

different case. 

9. Click Next.   

10. Click Send. 

11. The TrialDirector import wizard will guide you through the rest of the process. 

12. To view the clips, open the case in TrialDirector you exported the clips to. 

13. In the Case Explorer, open the folder that contains the DVT from which the clips 

were made. You will see the clips within the DVT folder.  

14. Double-click on the clip you want to view. 

15. The clip will begin playing. 

1. Click the Show/Hide Clip List button to open the Clip List if it is not already open. 

 

2. Select the clip(s) you would like to export. 

The [SHIFT] key is no longer required. 

3. Click the Export button.  

Note: It is recommended that you have CT Summation Enterprise/iBlaze 

running while exporting clips. 

  

4. The clip(s) you selected in step 2 will be checked. 
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5. Check the box next to any other clips you would like to export, or click Select All to 

select all clips. 

6. Select Summation(tm) Case. You will only be able to select trial presentation 

software that is installed on your computer. 

7. Click Next.   

8. You can either send the clips to the last case you were working on or select a 

different case from the drop-down list. 

9. Click Next.  

10. If you want to add a video transition at the beginning and end of each clip (and all 

segments within the clip), select a transition from the list. If you have selected to 

add video transitions, select a transition time from the list. 

11. Click Send. 

12. When the progress bars have reached the end, click Done. 

13. To view the clips, open the case in the Summation Enterprise/iBlaze file you 

exported the clips to. 

14. In the Transcripts folder, right-click on the DVT from which the clips were made to 

open the transcript.  

15. Right-click on the transcript and select Video Clips and then the Clip ID of the clip 

you want to view.  

16. The clip will begin playing. 
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Note: Please contact inData Technical Support for assistance in sending DepoView 

clips to Sanction 2.8 or 2.9. Please note that Sanction versions above 2.9 are NOT 

supported at this time. 

1. Click the Show/Hide Clip List button to open the Clip List if it is not already open. 

 

2. Select the clip(s) you would like to export. 

The [SHIFT] key is no longer required. 

3. Click the Export button.  

4. The clip(s) you selected in step 2 will be selected. 

5. Select any other clips you would like to export, or click Select All to select all clips. 

6. Select Sanction(tm) Case. You will only be able to select trial presentation 

software that is installed on your computer. 

7. Click Next. 

8. You can either send the clips to the last case you were working on or select a 

different case. 

9. Click Next.   

10. Click Send. 

11. When the progress bars have reached the end, click Done. 

12. To view the clips, first restart Sanction if it is open and then open the case to which 

the clips were exported. 

13. In the tree view, select the video from which the clips were made.  

14. In the list view, double-click on the Clip ID of the clip you want to view. 

15. The clip will begin playing. 

  



DepoView User Manual 

 

33 

To create and export a Clip Creation Script file (*.ccs) 

1. On the File menu, click Export Clip Creation Script File. 
2. The Clip Creation Script File (*.ccs) will automatically be made for you from existing 

clips in the Clip List. 

 

  

3. Select the folder where you want to save the Clip Creation Script file (*.ccs) and 
either keep the default file name or enter a different one. 

4. Click Save to save the Clip Creation Script file (*.ccs) to your chosen location. 
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To create and email a Clip Creation Script file (*.ccs) 

1. On the File menu, click Email Clip Creation Script File. 
2. The Clip Creation Script File (*.ccs) will automatically be made for you from existing 

clips in the Clip List.  
3. A new email message will open in your email program with the Clip Creation Script 

(*.ccs) attached.  
4. Send the email to the desired recipient(s). 

 

 


